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Mac OS X 
Version 10.4.6 Tiger 

 
Mac OS X is an operating system. An operating system controls HOW your computer works. 
 

The OS X MAC Desktop: 
 

 
 

1. Apple Menu – system settings, recent items, restart or shut down computer. 
 

2. View Buttons – as icons, in lists or in columns. This handout assumes a Columns view. 
 

3. Search Field – highlight folder you want searched, then type file name and press Return. 
 

4. Window Buttons (Colored Circles) – red = close window; yellow = minimize 
window to the Dock; green = resize window. 

 
5. Sidebar – Click icon to go to item. 

 
6. Home – contains personal folders for your login. NEVER rename these 

folders. You CAN add or rename new folders within these, however. 
 

7. Dock (customizable) – Icons to open applications, documents, folders and minimized windows. 
 

8. Finder Icon – Opens Finder window so you can see what is on your computer. 
 

9. Trash - Drag items to trash to delete them.  
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Use the Finder features to navigate to different parts of your computer. 
 

 
 

10. Application Menu – Shows name of program that is active. Use to set application’s 
preferences or quit program. 

 
11. Disk(s) – Macintosh HD always, and then any peripherals or CD-ROMS you insert. 
 
12. Folder – Containers to organize your files and applications. Double-click a folder to see what is 

inside. Choose “New Folder” from File menu to create one. 
 
13. Document – File you create using software applications. Can be opened by double clicking on 

name or by having the software application open it (File > Open). 
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Dock and Toolbar 
 

 
 

 
1. Toolbar – Back/Forward arrows, View buttons, Action options, Search. 
 
2. Sidebar – Click the icons to navigate around computer. 

 
3. Dock Applications – Icons of frequently used programs and windows that have been 

minimized. 
 
4. Triangles – small black triangles under an icon indicate that application is open. 
 
 

The Dock does NOT contain icons for every program. You can find other programs by clicking on 
Applications in the Sidebar and then scrolling through the list of programs in the next column.  
 
To add a program to your Dock, drag the application’s icon from the Finder column down to the 
Dock. To remove a program from your Dock, drag the application’s icon off of the Dock and let go. 
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To customize further, see the pictures on the next page. 
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Customize your Toolbar: 
 

• Under Finder’s View 
Menu, choose 
“Customize Toolbar.” 

• Drag items to the 
Toolbar. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Customize your Dock: 
 
Under the Apple Menu 
 

• Choose Dock / 
Dock Preferences 

 

Choosing “System 
Preferences” 

under the Apple 
Menu accesses 

System 
Preferences 
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District Standard Software  
And Online Subscription Resources 

 
Standard software is that which has been purposefully chosen for use throughout the district by curriculum, 
technology services, instructional media services, or by a particular team/department in the district such as 
Special Education or custodial staff.  Support and training is provided for this software. 
  
There is a district procedure for acquisition and use of software; see Technology Purchase Process in the 
Roseville Area Schools Media and Technology Services (online at 
http://www.isd623.org/edc/ps/it/mediatechpolicies.cfm). The following chart outlines current standards. 
 

Program Description 

 
iPhoto 

 
iPhoto 
 
Import, organize, edit, print, and share your digital photos. 

 
 (Microsoft 

Office*) 
Word 

 
Word (word processing) equipped with templates and wizards to help create useful documents. 
Some uses for Word include:  
• Creating reports, newsletters, business cards, labels and letters with illustrations 
• Tables and clip art in Word can be used for professional looking documents such as 

brochures and newsletters 
• Language tools: Spell and Grammar checking and Readability Statistics 
• Can create documents with the following extensions: .doc, .rtf, .html, .pdf 
Additional material can be found at http://office.microsoft.com/en-us/default.aspx and 
http://office.microsoft.com/en-us/FX011000841033.aspx.  
 

 
(Microsoft 
Office*) 

Power Point 

 
PowerPoint (presentations)  
Microsoft PowerPoint can be used to design effective presentations that can be delivered 
electronically, with overheads, or in paper form.  
Some uses of PowerPoint include:  
• Multimedia presentations and handouts 
• Web-delivered presentations (great for distance learning) 
• Slide shows and informational kiosks (a presentation that continually runs without human 

intervention) 
• Jeopardy and game-show type boards 
Additional material can be found at http://office.microsoft.com/en-us/default.aspx and 
http://office.microsoft.com/en-us/FX011000841033.aspx. 
 

 
(Microsoft 
Office*) 
Excel 

 
Excel (spreadsheets)  
Microsoft Excel is used largely for organizing, manipulating, and charting numerical and 
information data (spreadsheets and ledgers). You can use Excel to sort and chart both simple 
and complex data.  
Some uses for Excel include:  
• Organizing classroom and student information 
• Creating and tracking budgets 
• Sorting and charting data 
Additional material can be found at http://office.microsoft.com/en-us/default.aspx and 
http://office.microsoft.com/en-us/FX011000841033.aspx. 
 

Mac & 
OSX only 
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Inspiration* 

 
Inspiration v. 8 (Grades 6-12) 
• Pre-writing Outlines 
• Graphic Organizers 
• Drawing and Presentation 
• Creates .isf files; Using Export, documents can be many other types. 
View Inspiration Quick Tour on publisher’s website: 
http://www.inspiration.com/productinfo/Inspiration/interactive_demo/index.cfm  
 

 
World Book 

 
World Book Online Reference Center 
Web version of popular encyclopedia. Don’t miss the Educator’s Tools that correlate content with 
Minnesota Academic Standards. 
http://www.worldbookonline.com/ 
Login ID: isd623   Password: worldbook  
 

 
Making the 

Grade X 

 
Making the Grade X 
An electronic grade book that helps teachers manage class lessons. This program is compatible 
with our Teacher Web Publishing service, School Center. 
Visit the publisher’s web site at http://www.gradebusters.com 
 

 
Atomic 

Learning 

 
Atomic Learning for Software Training and Lesson Plans 
3 sections: 
• Computer software training films for PCs 
• Computer software training films for Macs 
• Curriculum Tools (Fantastic stuff!) 
www.atomiclearning.com 
Username: rosevilleisd   Password: isd623 (Subscription for all students and staff of ISD 623.) 
 

 
 

 
School Center 
A host for teacher web sites that can be managed from any computer with an Internet 
connection. Visit their web site at http://www.worldbookonline.com/.  
Contact your media specialist to have an account activated for you or your grade level. 
 

 
iMovie 

 
iMovie 
Video editing/production software for digital movies and slide shows. Mac and OS X only. 

 
Garage 
Band 

 
Garage Band 
Audio editing/production software for music, podcasts, and more. Mac and OS X only. 

 

SasiXP 
Student record-keeping attendance and grade reporting software.   

 
* License allows teachers to have copy on home computer as long as employed by ISD 623. Check out 
installation CDs from your Library Media Center. 
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Non-standard Software 
 
Software is considered “non-standard” if it no longer being updated, has been chosen by an individual or is 
needed by only a small group of people to meet their work, teaching, or learning needs. Individual users of “non-
standard” software will generally need to be responsible for their own support and training. 
 
To insure system stability, the acquisition and use of non-standard software also follows the district Technology 
Purchase Process (mentioned previously). District technology support staff need to determine any possible 
system conflicts.  In addition, the software owner needs to furnish tech support with packaging and license 
information. Copyright guidelines respected.  
 
Some of our non-standard software still commonly installed is as follows: 
 

 
Appleworks 

Word Processor, Drawing, 
Paint, Database, 
Spreadsheet, & 
Presentation. 

 
Keynote 

New Apple 
presentation 
software. Mac and 
OS X only. 

 
Pages 

New Apple word 
processing 
software. Mac 
and OS X only, 

 
Safari 

Apple Internet 
browser 

software. Mac 
and OS X only. 

 
Preview 

Apple .pdf 
reader 
software. Mac 
and OS X only. 
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Web Mail Basics 

 
Your email can now be accessed through Outlook Web Mail Access. 
 

• To access your Outlook Email Account via the Web, Go to http://webmail.isd623.org  
 
 

• At the login page, enter your username 
after AD\.  AD\ tells the server where to 
look for your account information and must 
be provided along with your username. 
Enter your password in the box below that,  
then click on the Log On button. 

• Public computers will log out automatically, 
and will not retain your login information.  
Private computers will cache your user 
information, allowing any one who uses 
your computer account access to your e-
mail. 

 
 
Once you log in you should see a screen with your email messages on the right and the Outlook Web 
Access menu on the left. 
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Web Mail Tool Bar  
 
Hover the mouse arrow over each icon (but do not click) to see what each icon is for. 
“Hovering” is a good way to get more icon information. 
 

 
 
The tool bar will change to match the context it appears on.  If you are viewing your calendar, 
the tool bar will display functions related to your calendar, and e-mail tools when viewing your 
inbox. 
 
Sending a New Message 
 

Open a new message to send by clicking  
on “new message” in the upper left corner of 
the screen, while in a mail folder. 

 
 
 
 
 

The easiest way to address an e-mail is to 
type your recipient’s name in the To… Field. 
You only need to include enough of the 
person’s name to identify them uniquely.  For 
example: typing B P will search for all people 
in your address book with the initials BP or 
PB.  For multiple recipients, separate the 
names by a semi-colon.  Click on the Check 
Names button.  Any ambiguities will be 
presented to you in a dialog on the left. 
 
You may also use the address book to select a recipient for a new message  
by clicking on “To”. This will open the Address Book.  The address book contains a list of 
all district employees, sorted by last name. 
 
*Note: The process is the same for including a copy (cc) of the email for another person(s) or for a Blind 
Carbon Copy (bcc). BCC is a useful feature for emailing a group of people (parents for example) where 
the email address of the recipients should remain private. 
 
Click on “Close” to go back to the message. 
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Add an Attachment to an Email Message 
 
Open a new email message. 
 
Click on “attachments”  
 
 
 
 
 
 
Click on “Browse” 
 
 
 
 
 
 
 
 
 
Navigate to the file to be attached and click “Open” 
 
 
 
 
 
 
 
 
 
 
 
 
Click on “Attach” button.   
 
The file to be attached should 
then show on the list under 
“Attachments.”   
 
Repeat process to send 
multiple attachments. 
 
 
 
 
Click on “Done” to return to your message. 
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Receiving an attachment: 
 
Open the email with attachment 
 
In “Attachments” area of the email, click on the name of the attachment. 
 
There are two ways to open the attachment: 
 

1. Click on the attachment.  This may 
open a blank Internet window along with 
this pop up window. 
 

Choose “open with” to see the file, or  
“Save to Disc”  
 

Click “ok” 
 
  
OR 
 
2. CONTROL CLICK on the attachment (hold 

down the “ctrl” button on the keyboard and click 
the mouse on the attachment) you will get a menu 
with choices.  
  

Choose ”Save link as….” and navigate to the 
folder where you would like to save the 
attachment. 

 
 



August, 2008 Web Mail Basics      5 of 5 
 

 
Add a new contact 
 
Select Contacts from the Outlook Web Access Menu  
on the left hand side of the screen. 
 
Click “New Contact” 
 
 
 
 
 
 
Enter First and Last Name, 
“Display” name and email  
This information is required. 
The other fields are 
optional. 
 
 
Click “Save and Close” in 
the upper left hand corner. 
 
 
 
 
 
 
 
 



Entourage Basics 
The district has adopted Microsoft Entourage as the 
default application for accessing your email from an OS 
X computer.  In order to make this work for you, you 

will need to setup entourage by following a step by script.  Please launch “Entourage 
Setup.app” the first time you want to check your mail.   
 
Once you log in you will be greeted with a screen that is very similar to Microsoft 
Outlook.  

 
TO View your mailbox, click on the triangle by your mailbox.   

 
The Toolbar 

 
The toolbar is active when you highlight a message.  Hover your mouse over any icon 
(but don’t click) to find out what the icon is for.   

New Message 
Open a new message by clicking on the new Message button.   

 
Then type the name or a part of the name of the recipient.  A pop-up box will list all of 
the addresses in your address book that matches this name.   
 

 
When you select a name you can add more names or click on the 
subject field to continue writing the message.  In the message body you will notice that 
misspelled words are underlined with a red-wavy line.   

Your inbox is hidden 
in your 
Mailbox at first 



 
Add an Attachment 

 
To add an attachment, first click on the message’s attachment triangle to reveal this part 
of the message.   

 
Within the attachments section of the message there is an add button.   

 
When you click this button a dialog box opens that asks you to locate the file.  When you 
find the file that you would like to attach click on this and then click the choose button.    

 
 

Receiving an Attachment: 
 

When you are reading your email, messages that have attachments will have a paperclip 
in the bottom right edge of the message.  Click on the message.   

 
On the right-hand pane of entourage you will see an attachment section.  Highlight the 
attachment and choose save.   

 
BEWARE! Attachments can, and often do, contain viruses.  Open attachments only 
when you expect to receive them.  
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Add a New Contact 

To organize your contacts you will need to click on the address book.   
To add a new contact, first select your mailbox on the list of mailboxes in the left-0hand 
pane.   

Then click on the new contact button in the toolbar.   

 Then you will need to fill out the name and email address of the new 
contact in your book and choose save:  

 
 

Make a Distribution List 
To add a new distribution list, first select your mailbox on the list of mailboxes in the 
left-hand pane.   

 In the address book click on add group.   
Name the group.  And then enter the names of each member just as you would an email 
message.   
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Using Microsoft Word for 
Word Processing 

 
Opening Word for new document 

  
• Click W icon on dock located at edge of 

desktop 

• Project Gallery will open 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Word Document is highlighted 
• Click on open button at lower right 

 
Saving a new Word document 
 

 Click on File drop down menu (located at top) 
 Drag down to click on Save As 
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 A Save As window will appear where you can type in the title of your document. 
 
 

 
 
 
 
 
 
 
 
 

 Click on highlighted Save button 
 
 
Retrieving Saved Files 
  

 Find Documents icon on dock or 
sidebar 

 Click to open 
 Scroll to find file name 
 Double click on file title 

 
 
 

Making a PDF  
 
A PDF is a portable document format that is viewable by anyone with a computer using .pdf reader programs 
such as “Adobe Acrobat Reader” or “Preview.” Mac OS X allows most word processing documents to be turned 
into .pdf documents. You would do this if you wanted to post a document on your web site. Computers with 
Internet connectivity most all have .pdf readers, so the viewer does not have to have the  type of software in 
which the document was created. 
 

 With your document open, go under the File menu and select Print . (Trust us, this 
works! You are not really going to Print, you’re going to Save As PDF.) 

 When the Print window opens, select “Save as PDF”  from the PDF drop-down menu in 
the lower left corner of the window. 

 
 

 Name your the document and save it to your documents folder. 
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Transitioning Away from AppleWorks 
 
As long as AppleWorks continues to function with Mac OS X, it will remain available for staff and student use. 
However, AppleWorks is a program that will not be updated anymore, so eventually it will probably stop working. 
This is why the district no longer supports it as part of District Standard Software, and we recommend that you 
begin to use  Microsoft Office (Word, PowerPoint or Excel). 
 
Word processed 
documents transfer easily 
to MS Word. AppleWorks 
may let you choose a Word 
format when you use “Save 
As”.  In the lower left corner 
of the Save As window, go to 
File Format and look through 
your choices. If you can, 
select  Word Mac 98, 2001, 
document. 
Then click Save. 
 
If that fails, try to copy the 
content of your AppleWorks 
document and pasting it into 
a blank Word document. 
 
As a 3rd option, the district 
has purchased the new 
Apple suite that has Pages, a word processing program that can open and read .cwk files and Keynote a new 
Apple presentation software. You can try these programs, but you will find that MS Office programs are much 
more universally found on computers than the Apple programs. Your students are more likely to be familiar with 
Office if they have a home computer. Office documents do go between platforms easily (Mac to PC and vice 
versa). 
 
Spreadsheets also transfer quite easily into MS Excel documents. Again, you can first try to get AppleWorks 
to “Save As” Excel. If that is unsuccessful, copy and paste your content from the AppleWorks spreadsheet to a 
blank Excel document. 
 
Drawing and Painting do not have an Office equivalent, though Word and PowerPoint do have drawing 
ability.  If you want to ensure always being able to open these document types, you can save them as .jpeg 
images. (Again, this is an option from AppleWorks ”Save As” “File Format” dialog. But keep in mind that .jpegs 
are not editable images. 
 
And don’t forget to try out the drawing and painting features of Kid Pix, 
Kidspiration or Inspiration to see if they will meet your needs. 
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Firefox Basics  
 
What is a browser? 
 

• A browser is a software program that allows you to look at sites on the Internet. 
• Internet Explorer and Netscape are browsers we have used in the past.  
• Firefox is the browser currently recommended and supported by the district. Either 

Macs or Windows computers can use it. 
 
This is the icon for Firefox that is in your dock.  
 
The Toolbar is at the top of your Firefox browser window.   

 
 

Setting Your Homepage: 
 

1. Start Firefox by clicking on the icon in the dock. 
 

2. Once the program loads, type the URL (address) of the webpage you 
would like to have as your homepage, such as www.isd623.org. 

 
3. Under the Firefox menu, pull down to select Preferences. 

 
4. In the top of the Preferences window, select Use Current Page 

 
 

5. At the bottom of the Preferences window, click on OK 
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Adding Bookmarks 
 

1 
Find Webmail in the staff collection 
on the Navigation bar on most District 
Websites 

2 Choose the menu Bookmarks 
Bookmark this page 

 

3 
To return to the bookmark, select 
bookmarks and select your new 
email bookmark from the menu 
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Add a Bookmark to the Bookmark Toolbar 

 

(Another way to make a bookmark!) 
 

1 
 
Repeat steps 1 through 3 for adding a bookmark listed on the previous page 
 

2 

After you select 
“bookmark this 
page”, click on the 
drop down menu 
arrows 

 

3 
Select “Bookmarks 
Toolbar Folder” 
and click “Add” 

 

4 

The link should 
appear in the 
Firefox Bookmarks 
Toolbar 

 



Logging on to CLASSXP
To use the Classxp attendance system there are two levels of security. The first step is to login 
to your computer. Only staff  have access to use Classxp.
 For security reasons please logout before allowing students to use .your computer 

To Logon:
Step 1
Login in to your computer by entering your login name and password

Step 2
Find the ClassXP Icon on your dock, and click it to open ClassXP

Step 3
The next screen is the login to  Classxp  This is the second 
level  of security. Use your standard login name. Your
password is the same as your user ID . Be sure to change
your password from the default!  You can change your
password by clicking the Change Password box.

•Click the mouse in the user ID box and enter user ID.
•Hit tab to move to the password box.
•Enter your password which is the same as your User ID.
•Press return or Click Login box.

Step 4
Choose the hour you wish to work with 
by doubleclicking.

. 

Click this box to change the classes 
displayed. You can view  entire year 
classes or  Semester  classes 



Taking Attendance
To take attendance:
Step 1
Go the the Class Menu  and Choose Take attendance

.

Use the mouse to select the student. you wish to work with.
Click once  on the student’s name to mark absent or UNV for unverified.
Click twice  to mark the student tardy
Click three times  to return the student’s status to present.
 

Step 2
When you are finished taking attendance go to the top of the screen and click on the 
to stop taking attendance. Your class attendance is immediately recorded.



Student Information in CLASSxp
CLASSxp gives teachers access to information on the students in their class(es).

To view information on a student, click once 
on the student picture so they are highlighted in red.
Then click the Personal menu to look up student 
information.

You have access to the following areas of student information:

Demographic
This area gives basic student information, such as primary 
phone number, address, and parent/guardian name.

Class Schedule
Contains the class schedule of the student for the school year. 

Period Attendance
You can view a student’s attendance across all class periods
for the year in this window.  
Click the Days of Activity, Reason Totals, and Type Totals
tabs at the top of the screen to see summaries of the
student’s absences.

Parent/Guardian
This window contains information on a student’s parents,
emergency contacts, and other relevant persons.
Click the numbered sidebar to scroll between records for
each student.

The Emergency, Health, and Discipline selections 
on the Personal menu are not used.

Several reports can also be run from the Personal menu that you may find useful.
Please note that the information presented in these reports is only for the current class selected.

Reports from Period Attendance, Period-Attendance menu:
ATP13, Report by Student -- Gives an attendance summary, per student.

Reports from Student Demographics, Student menu:
STU02, Student Directory --  A list of students with parent/guardian and contact information.
STU25, Birthday Listing -- Students and birthdates, sorted by month.
STU41, Class Roster w/ Schedule -- Prints students and their schedules.



Editing Attendance Information

Important note:
Please do not change an absence reason other than UNV (Unverified) and TDY (Tardy).  Even if 
you know a student was absent for another reason, it is the responsibility of the attendance office 
to record this. 

To change today’s attendance:

CLASSxp will allow you to take attendance more than
 once on the same day.  Go to the Class menu and 
choose Take Attendance as usual.

To change yesterday’s attendance:

Go to the Class menu, and select Class Attendance. 
You may change only the previous school day’s attendance!

Additional Tips and Tricks
To quickly print a class roster:
1. Go to the Class menu and choose Show Student List.
2. Go to the File menu, and choose Print.
3.  Change the Printout Title to something descriptive,

like, “1st Hour Math.”  Select “An expanded table” and
check off “Print Row Dividing Lines.” Click OK.

Note:  This will print a blank sheet after your class roster.
This is normal.

To print your current seating chart:
As you know, the Seating Chart Report in CLASSxp has never worked. Here is another way to 
print the layout of your seating chart.
1.  Open the class.
2.  Hold down      - SHIFT - 4  at the same time. Your mouse pointer will turn into a cross.
3.  Drag a box around your seating chart.  When you let go of the mouse button, your computer 

will make the sound of a camera shutter.
4.  Open your staff documents folder on the server.  A file called, “Picture 1” will be there. Double-

click it, and a picture of the seating chart will open.  Go to the File menu, and Print. Then go to 
the File Menu, and Quit.

5.  Delete “Picture 1” from your document folder.  Repeat steps 1-5 for each class.

To export a class list:
1. Go to the Class menu, and choose Show Class Attendance.
2. Go to the Data menu, and choose Export List.  Choose your save location, and give the file a 

name. Hit Save.
3. Another Save box will appear. Click CANCEL.

Your student list can be opened in ClarisWorks, or imported into Making the Grade.



SASIxp Classroom automatically displays 
the names of students entering a class 
when you first bring up the class.  

How to Use the Show Students Entering Function

To add new students to your seating chart.

Click and hold the mouse button on 
each students’ name and drag the name 
from STUDENTS ENTERING list to the 
seating chart.

ClassXP Seating Chart Information

To  remove and change students displayed in the chart 
Go the CLASS menu and Choose Show student list

 Select a student from the STUDENTS OUT 
OF CHART by clicking on the name and 
drag it to the seating chart

TO ADD A STUDENT 

TO REMOVE A STUDENT 
Select the student you want to remove 
from the IN CHART LIST and drag the 
name to the OUT OF CHART list

RAHS TECHNOLOGY SERVICES 9/98



 1. Select  Seating Chart.... from the Class menu.  

Creating and Modifying Seating Charts
To change the size of the seating chart grid

Go to Class Menu  and choose Preferences.
and select  CLASS...

1.

2. The default size is 6 x7. You can increase the
rows and columns to display larger class sizes
To have the changes take effect you must leave 
close and reopen the class.

To Create a New Seating chart

2. Enter a new name for the chart  and select ADD
3.  After the blank chart is created. Click Student List 
to display all students names.

4. Select each students name and drag onto 
the chart in the order you wish 

5. If you would like this to be your default seating chart. 
Go to the SEATING CHARTS window

Select  CHART 1 and choose REMOVE.

This will make the chart you created become the seating 
chart displayed each time you open the hour

RAHS TECHNOLOGY SERVICES 9/98

3. After you reopen the class you will have to resize the 
seating chart window to see the large chart grid



Initial Making the Grade Setup - Importing Student name from Classxp

To use Schoolcenter you MUST have student ID # configured in Making the Grade.
Below are instructions for exporting student ID# from Classxp.

1. Open Classxp and choose a class

These steps must be done for every class

2. Double click on the In Folder in the lower right corner

3. Double - click on the MakingtheGrade export icon

4. Choose Export  from the Query Window

5. Choose Ok from the Export window

6.  Choose where you would like to save the file and type the name of the class and 
hour you are exporting then Choose Save.

7. Open Making the Grade and create a new gradebook file for your class

8. Follow the setup screens

9. Locate the file you exported from Classxp and choose import

A. Make sure you enter a course number

B. Choose Your Own Numbers  from Step 2 Student setup window

You have now saved a text file with student names and ID #.  The next step is 
to import this file into Making the Grade.

C. On the student ID setup screen Choose Import

D.  Choose ASCII/Text from the selection window

10. You should now see your student names and IDs displayed. 
                            Choose Done.

Your have now setup Making the Grade so it will properly interface with Schoolcenter!
For specific directions on how to upload grades to Schoolcenter refer to the
 Uploading Grades Handout.



Uploading Grades to SchoolCenter Web Site

Setting up Making the Grade

Note :You must be using version 9.4 or higher of Making the Grade to upload.

Before you upload grades to SchoolCenter you must complete a one time setup step
 in the Making the Grade file of each class. 

Open your existing Making the Grading file

1. Go to Edit Menu - Setup-  Class Information- Class Title

2. Enter the Sasixp course # of the class in the Course Number.
     You can find the course # at the top left hand corner of your absences lists 

3. Save your changes and open your next grading file

You must enter a course # for each class you wish to upload to SchoolCenter.

Before you can upload grades to Schoolcenter your Making the Grade files must have 
Sasixp student IDs entered for each student and a course ID entered for each class.. 

If you have not already entered student IDs or imported student IDs from Sasixp follow the 
directions below:

Open Making the Grade file and Go to the Edit Menu

Choose Setup Info- Class Information - Student Numbers

Choose your own numbers at the next screen 

Enter Sasixp student IDs from your class roster sheet for each students.

Setting up Course IDs

Entering Student IDs



After you select Next from the upload screen you will be prompted
Save the Making the Grade Class - Choose Yes

You should now get the Message that the export was successful

The SchoolCenter.xml file will be saved in the 
SAME FOLDER AS YOUR MAKING THE GRADE FILES.

Do NOT rename this file it must be named SchoolCenter.xml.

Uploading Grades to SchoolCenter 

Step 1

PART ONE :Export Grades to an XML file from Making the Grade

Go to FIle-Export Student Data

Choose SchoolCenter

Step 2 Select the Making the Grade Classes you 
wish to upload

If you only want to upload only the class displayed Select Next

If you wish to add additional Making the Grade Classes

Select Add

Navigate to the other Making
the Grade files you wish to upload

Select Include
Select Done when you have added all classes

Open a Making the Grade Class

When you have added all of the classes you wish to upload Select Next



PART TWO: Uploading to SchoolCenter web site

Open Internet Explorer and Login to Schoolcenter.
http://roseville.mn.schoolwebpages.com/admin

After you have logged in you should see a blue bar on the right side

Click on the small + on the blue bar

When the menu displays Choose Grades

Choose Upload Grades  from the next screen

Choose Browse from the Upload Grades window

Locate the SchoolCenter.xml file and choose Open. The file should be 
saved in the same folder as your Making the Grade class files.

FINAL STEP Scroll to the bottom of the preview window and select             
the Blue FINISH  link to complete the upload.

The screen should now display a preview of your class grades

Note: There is a software bug in some web browser where you do not see the preview 
window. However, the upload functions correctly. 

To verify your upload select Manage Classes.

Verifying your Upload

All of your classes should be listed. To view and check grades within a class click on the 
class title.



 
Where can I find 

technology training? 
 
 

 
 
1. Atomic Learning 
 

Atomic Learning is a web site with a self-directed training videos and curriculum 
resources.  Tutorials are available for both Windows and Mac computers.  
 
To access Atomic Learning on a district computer: 

 
Open a web browser.   Go to www.atomiclearning.com. 

 
Near the top of the window, click on Windows Tutorials, Macintosh Tutorials or 
Curriculum Tools. 

  
 
 
 
 
 

Scroll or use the search box to find a tutorial. 
 
Video clips are arranged in an outline format.  Clips are short, from 45 seconds to 3 
minutes. 
 
To access Atomic Learning from outside the district: 

 
Open a web browser .  Go to www.atomiclearning.com 
Login with the following: 

Username:  rosevilleisd Password:     isd623 
 
 
2. Media/Tech Professional Development Web Page 
  http://www.isd623.org/edc/ps/it/mtprofdev.cfm 
 
 
3.  Contact your Library Media Specialist!  

 
 



Getting Help 
 
 
Reporting Issues: 
 
District Technology Support Request System 
Most issues should be reported online using the Technical Support Request system 
located at www.isd623.org/technology/help.cfm. This system is intended to allow 
District Technology Support to efficiently assist as many staff as possible. 
 
Technology Support Hotline 
Urgent issues may be reported by calling the helpdesk at 651-604-1476. 
 
 
District Technology Services Staff  
Contact Position Phone # Description 
Tina Clasen District Technology 

Services Supervisor 
604-1476 • Technology Services 

Project Coordination  
Brandon Peterson District Helpdesk 

Manager 
604-1476 • Helpdesk Manager 

    
John Bailey District Helpdesk  

Specialist 
604-1476 • Macintosh Support & 

Repair 
 

Clint Foster District Helpdesk 
Specialist 

604-1476 • Computer Support & 
Hardware Repair 

Mike Koopman District Helpdesk 
Specialist 

604-1476 • Windows Support & 
Hardware Repair 

Jon McCullough District Helpdesk 
Specialist 

604-1476 • Macintosh Support & 
Repair 

Jason Meyer District Network 
Manager 

604-1476 • Network Management 

Sean Thao District Audio-Video 
Specialist 

604-1476 • AV Equipment Check Out 
& Repair 

• Video Production Support 
• Telephone/Voicemail 

Support 
 
 
 
 
 
  
 


